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EXECUTIVE OVERVIEW

Traditional models for IT delivery often cause infrastructure silos, leading to low utilization
and high labor costs. Each traditional infrastructure appliance usually has a standalone
management interface and requires expensive specialized training. Organizations are
constantly challenged to provide a robust, predictable, and dependable environment
against a backdrop of ever-increasing volume of data, users, and operations. Given this,
the deployment of data center infrastructure can be complex, time consuming, and costly.
It is the goal of this design guide to provide a reliable, scalable, easy-to-manage, and high
performance platform for consolidated workloads and private cloud environments.

This document describes a reference architecture for deploying a highly-available

and scale-out Microsoft® File Server solution with Microsoft Windows® Storage Server
2016. We will showcase the ease of deploying a scalable file services environment with
Microsoft Windows Storage Server 2016 native Server Message Block (SMB) support.

Scale-Out File Services is a capability that is designed to provide highly-available scale-
out file shares that are continuously available for file-based storage such as home
directories and SMB shares. This scenario focuses on how to plan for and deploy Scale-
Out File Server.

GOALS AND OBJECTIVES

This document provides a high-level design for customers seeking to implement a green-
field deployment or to move/migrate from an existing Network Attached Storage (NAS)
solution to a Pure Storage® FlashArray solution with Microsoft Windows Storage Server
2016. We provide guidance on Windows Storage Server 2016 R2 Standard components
with Pure Storage for hosting SAN and SMB shares for end users.

AUDIENCE

The target audiences for this document are storage and virtualization administrators,
data center architects, field engineers, and server specialists.

DESIGN GUIDE PRINCIPLES

The guiding principles for implementing this reference architecture are:

- Availability — Create a design that is resilient and not prone to failure of a single
component. For example, we include best practices to enforce multiple paths to
storage using MPIO with Windows Server Failover Clustering.

- Efficient — Build a solution that leverages the efficiency benefits of an all-flash
architecture, including data reduction with in-line deduplication and compression,
100% encryption of data at rest, and an Evergreen system architecture.

- Simple — Simplify deployment and ongoing maintenance tasks via automation.
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- Scalable — Create a design that can start small but easily expand to the meet the
needs of a growing organization’s file system needs.

Please see appendices to this document for a detailed overview of Cisco UCSE,
Cisco Nexus®, Pure Storage FlashArray//M, and Microsoft components used in this
design guide.

TOPOLOGY

In this section, we will learn more about the high-level topology of the reference
architecture. It comprises the following hardware and software components:

HARDWARE

« Compute — Cisco UCS Mini [Cisco UCS B200 M4 Blade Server + Cisco UCS 5108
Blade Server Chassis]

+ Network — Cisco UCS Fabric Interconnect 6324 for external and internal
connectivity of IP and FC network.

« Storage — Pure Storage FlashArray//M

SOFTWARE

« Cisco UCS Manager

« Cisco UCS Firmware (version 3.1.1E)

«  Microsoft Windows Storage Server 2016

«  Pure Storage Web Management interface

« Pure Storage PowerShell SDK
Figure 1shows a detailed topology of the reference architecture configuration. A major
goal of the architecture is to build out a highly redundant and resilient infrastructure.
We used powerful servers with dual Fibre Channel ports connected redundantly to two

SAN switches that were connected to redundant FC target ports on the FlashArray//m.
The servers also have redundant network connectivity. It is configured in End-Host Mode.
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Figure 1. Cisco UCS and Pure Storage FlashArray connectivity

The use case for implementing this reference architecture is:

Simplified Provisioning — Reduce the complexity of provisioning new SAN or
SMB shares and reduce time spent on common tasks.

Ongoing Maintenance — Reduce overhead of ongoing maintenance by avoiding
the need to tune the environment.

Performance — Enhance infrastructure to improve performance and scale.

Availability — Maintain a highly available application storage and file
services environment.

Protection — Integrate data protection to minimize data loss and recover data,
as needed.

Cost — Provide a cost-efficient solution that supports the SMB use case with
the option to add NFS.

CONFIGURATION & DEPLOYMENT

The configuration of this reference architecture is as follows:

{® puresTORAGE

Pure Storage FlashArray//M20
Cisco Nexus 5000

Cisco 6248 Fabric Interconnect
Purity 4.8.5

Windows Storage Server 2016
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The following Windows Storage Server 2016 components are used:

Block I/O

Storage
Area
Network
(SAN)

Server Message Block (SMB)

File and Storage Services

File Server Resource
Manager

SMB Scale-Out

Failover Clustering

VSS for SMB

Volume Shadow Copy Service (VSS)

Clustered Shared Volume (CSV)

NTFS

Windows Storage Server 2016

Infrastructure

Figure 2. Logical services diagram

The following sections explain the procedure to setup and configure the listed portions
of the Cisco UCS environment for SoFS:

—_

o W N

UCS Manager configuration
Configure SAN boot
Setup Windows Storage Server 2016

Configure Windows Failover Clustering

Configure Server Message Block (SMB) for high availability

This deployment guide assumes that the Cisco environment has been fully configured
with servers (blades) online, switches, and zoning.

 PuresTORAGE:
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STEP 1-
UCS MANAGER CONFIGURATION

To log in to the Cisco Unified Computing System (UCS) environment, complete the
following steps:

1. Open a web browser and navigate to the Cisco UCS 6248UP Fabric Interconnect
IP address.

2. Click the Launch UCS Manager link to download the Cisco UCS Manager software.
3. If prompted, accept the security certificate.

4. When prompted, enter admin as the user name and enter the administrative
password.

5. Click Login to access the UCS Manager.

ADD BLOCK OF IP ADDRESSES FOR KVM ACCESS

To create a block of IP addresses for server keyboard, video, mouse (KVM) access in the
Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, in the navigation pane, click the LAN tab.
2. Select Pools > root > IP Pools > IP Pool ext-mgmt.

3. Inthe Actions pane, select Create Block of IPv4 Addresses.

This block of IP addresses should be in the same subnet as the management
IP addresses for the Cisco UCS Manager.

Fault Summary Q © wNewv |[J0ptons | © © | 7 PendngAchvies | Fing | @Ea |

e 196 r » Sy @ross gyreot v BEIP Peoks v 8IP Pool extamgmt 2P Pool extamgr
‘ Seevees N SAN b 3| Gewest ® Adresses 1P Bocs Fauts Eveets
o — s
[l N Tomplato vNICS - Name  extamget
~ ¥
VNIC Template vNICT
=mncv " B Create Block of IPvs Addresses Descripaon
gl v 04000000.5003.0000-0000.000000000000
e ey 1B Create Block of 1Pv6 Addresses °: e
[ VN Tomplate WIN-NICS " Assigned 55
» £, Sub-Organizanons k] Assignmant Oraar - [ Dafastt () Sequenial
« @ Pooks S show post usage
v!‘i‘lﬂﬂ
'.IPVM
BT

110218831, 10218238
110218840 10218359)
110218860 10218862
110218883 1021 8383
110218287 10218398
» I 1P Peol tscss-intator-pool
» B MAC Posts
» /) Sub-Organtzaors
* [ Traffc Monoring Sessions
» o Fabnc A

v
> o Fabrc B

Figure 3. Adding block of IP addresses
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4. Enter the following:

Starting IP address of the block in the From field

Number of IP addresses required in the Size field

Subnet Mask

Default Gateway

Primary DNS
Secondary DNS

A Create Block of IPv4 Addresses o
Create a Block of IPv4 Addresses ©
Fom - GO o
Subnet Mask - 255 255 255.0 Defautt Gateway - SN
Primary NS 0000 Secondary DNS :0.0.0.0
oK | [ Cancel

Figure 4. Creating block of IPv4 addresses

5. Click OK to create the IP block.

6. Click OK in the confirmation message.

EDIT CHASSIS DISCOVERY POLICY

Setting the discovery policy simplifies the addition of B-Series Cisco UCS chassis and
C-Series servers. To modify the chassis discovery policy, complete the following steps:

1. In Cisco UCS Manager, in the left navigation pane, click the Equipment tab and
select Equipment from the list.

2. Inthe right pane, click the Policies tab.

3. Under Global Policies, set the Chassis/FEX Discovery Policy to 2-link or set it
to match the number of uplink ports that are cabled between the chassis and the
fabric interconnects.
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Figure 5. Editing chassis discovery policy

4. Click Save Changes.
5. Click OK.

ENABLE SERVER, UPLINK, AND FC PORTS

To enable server, uplink, and FC ports, complete the following steps:
1. In Cisco UCS Manager, in the left navigation pane, click the Equipment tab.

2. Select Equipment > Fabric Interconnects > Fabric Interconnect A (primary) >
Fixed Module.

3. Expand Ethernet Ports.

4. Select the ports that are connected to the chassis or directly connected to C-Series
rack servers, right-click them, and select Configure as Server Port.

5. Click Yes to confirm server ports and click OK.

6. Select the ports that are connected to the Cisco Nexus 5000 switches, right-click
them, and select Configure as Uplink Port.

Click Yes to confirm uplink ports and click OK.

8. Select the ports that are connected to the Cisco Nexus 5000 switches, right-click
them, and select Configure as FC Port.

9. Inthe left pane, navigate to Fabric Interconnect A (primary). In the right pane,
navigate to the Physical Ports tab >Ethernet Ports tab. Confirm that ports have been
configured correctly in the If Role column.

©2017 Pure Storage, Inc. 9
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Figure 6. Configuring ports

10. Follow the steps 1— 9 for Fabric Interconnect B (subordinate).

ACKNOWLEDGE CISCO UCS CHASSIS

To acknowledge all Cisco UCS chassis, complete the following steps:
1. In Cisco UCS Manager, in the left navigation pane, click the Equipment tab.
2. Expand Chassis and select each chassis that is listed.

3. Right-click each chassis and select Acknowledge Chassis.

SELLoy® |

F-ié-vyv ~ . Q @ TNewv | 2ogons | ) © | 7 PendngAcvites | ¥ Find | @Ex |
6 19 7 » S5 Equpment v wy Chassis » g Chassis 2
4 Equipment Servers VNP ® 4 General Servers Senvice Profies 10 Modules Fans PSUs Hyteid Disphay Siots Istated Frmware
Filter:
L Faul Sumenary
e ~ (] A A
- it Chaesie o w0 ° 1
» wp Chassis 1)
Status
'.F.H Overall Status 'V Powes Protiesn
» 8910 Moduses
- @rev » Status Dotails
* < Servers
» o et Actions
* <. Sarver2 R Adnowtedge Chaesic
v Suva) W Decommission Chassss
* W nowmes WY Remove Chassss
' 4 @ Tum oa Locater LED
» < Server §
<=t 4 View POST Resuls
i Bt P st Faut suppression o
> o Sover 8 @ Product Name - Cisco UCS 5108 AC2 Chassis
» w Chassis 3 G suppression Tk Properties Vendor - Cisco Systems inc D UCSRA108.AC?
e —= Revsion -0 Seral FOX1931GRSW
> s 3
- ¥ Save Gunges

Reset Values

Figure 7. Acknowledging the chassis
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CREATE MAC ADDRESS POOLS

To configure the necessary MAC address pools for the Cisco UCS environment, complete
the following steps:

N

In Cisco UCS Manager, click the LAN tab in the left navigation pane.
Select Pools > root.

Right-click MAC Pools under the root organization.

Select Create MAC Pool to create the MAC address pool.

Enter the Name for MAC pool.

o oA W N

Optional: Enter a Description for the MAC pool.

Keep the Assignment Order at Default.

Unified Computing System Manager

1. Xpofine Name and

Description
2 Dadamac Addresses

Figure 8. Create MAC addresses pool

7. Click Next.
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A Create MAC Pool

Unified Computing System Manager

Create MAC Pool Define Name and Description o
1. XDefine Name and

Description neme [
7L D adamac Addresses Description -

Assignment Order : |(®) Default () Sequential

< Prev Next > Finish Cancel |

Figure 9. Define name and description of MAC pool

8. Click Add.

9. Specify a starting MAC address in the First MAC address field.

A Create a Block of MAC Addresses x
Create a Block of MAC Addresses e
First MAC Address : size ;1 3
To ensure uniqueness of MACs in the LAN fabric, you are strongly encouraged to use the following MAC
prefix:
00:25:B5:xx:XX:XX
OK | [ Cancel |

Figure 10. Create block of MAC addresses

10. Click OK.
11. Click Finish.

12. In the confirmation message window, click OK.

CREATE WWNN POOLS

To configure the necessary World Wide Node Name (WWNN) pools for the Cisco UCS
environment, complete the following steps:

1. In Cisco UCS Manager, click the SAN tab in the left navigation pane.

2. Select Pools > root.

o PURESTORAGE’ ©2017 Pure Storage, Inc. 12



Right-click WWNN Pools.

Select Create WWNN Pool.

Enter the Name for WWNN pool.

Optional: Add a Description for the WWNN pool.

N o oo oW

Click on Default radio button for the Assignment Order.

A Create WWNN Pool X

Unified Computing System Manager

\Create WWNN Pool Define Name and Description o
1. X Define Name and
Description name - [
2. L) ada wwn Blocks Descripson

Assignment Order : (s) Default () Sequential

< Prev Next > Finish Cancel |
Figure 11. Define name and description of WWNN pool
8. Click Next.
A Create WWNN Pool X

Unified Computing System Manager

Create WWNN Pool Add WWN Blocks ©
1. ¥ Define Name and
Description # =) &Fier =EBgot (JPrint G
2. Jadd wwh Blocks ‘Name | From To
No data available

[ Add {3 Delete

[ < Prev Next > [ Fnish | [ Cancel |

Figure 12. Add WWNN block

9. Click Add to add a block of WWNNs.
10. Either retain the default block of WWNNSs, or specify a base WWNN.

o PURESTORAGE’ ©2017 Pure Storage, Inc. 13



11. Specify a Size for the WWNN block.

A Create WWN Block

Create WWN Block

From :| 20:00:00:25:85:00:00:00 size (1 3

To ensure uniqueness of WWNs in the SAN fabric. you are strongly encouraged to use
the following WWN prefix:

20:00:00:25:D5:XX:XX:XX

Figure 13. Create WWN block

12. Click OK.
13. Click Finish.
14. Click OK.

CREATE WWPN POOLS

To configure the necessary World Wide Port Name (WWPN) pools for the Cisco UCS
environment, complete the following steps:

1.

® N O oA W

In Cisco UCS Manager, click the SAN tab in the left navigation pane.
Select Pools > root.

Right-click WWPN Pools.

Select Create WWPN Pool.

Enter the Name for WWPN pool.

Optional: Enter a Description for this WWPN pool.

Click the Default radio button for Assignment Order.

Click Next.

o PURESTORAGE’ ©2017 Pure Storage, Inc. 14



A Create WWPN Pool X

Unified Computing System Manager

Create WWPN Pool Add WWN Blocks 2]
1. ¥ Define Name and
Description & =) & Filter wbBport (FPrint v
2. Jadd wwn Blocks “Name “From T —
No data available

Add ¥ Delete

<Prev.] | Next> | [Finish.] [ Cancel. ]

Figure 14. Add WWN blocks

9. Click Add to add a block of WWPNSs.
10. Specify the starting WWPN in the block.
11. Specify a Size for the WWPN block.

A Create WWN Block

Create WWN Block

From :| 20:00:00:25:85:00:00:00 Size :E]

To ensure uniqueness of WWNs in the SAN fabric, you are strongly encouraged to use
the following WWN prefix:

20:00:00:25:b5:xx:XX:XX

Figure 15. Create WWPN block

12. Click OK.

o PURESTORAGE’ ©2017 Pure Storage, Inc. 15



A Create WWPN Pool X

Unified Computing System Manager

Create WWPN Pool Add WWN Blocks ©
1. VDefine Name and
Description & = @Fiter @Export S Print Gy
2. Jadd wwn Blocks Name From To
! [20:00:00:25:85:00:0...  20:00:00:25:85:00:00:00 20:00:00:25:85:00:00:00

Add 7 Delete

{[<prev || Next> | (Fimsh ) [(Cance

Figure 16. Complete the creation of WWPN pool

13. Click Finish to create the WWPN pool.
14. Click OK.

CREATE UUID SUFFIX POOL

To configure the necessary universally unique identifier (UUID) suffix pool for the
Cisco UCS environment, complete the following steps:

—_

In Cisco UCS Manager, click the Servers tab in the left navigation pane.
Select Pools > root.

Right-click UUID Suffix Pools.

Select Create UUID Suffix Pool.

Enter the Name for UUID suffix pool.

Optional: Enter a Description for UUID suffix pool.

Click the Derived radio button for Prefix.

® N oA W N

Click the Default radio button for the Assignment Order.

o PURESTORAGE’ ©2017 Pure Storage, Inc. 16



A Create UUID Suffix Pool X

Unified Computing System Manager

Create UUID Sufix Pool Define Name and Description o
1. X Define Name and
Descrption e -
2. '-]And UUID Blocks Description

Prefix -|@) Derived O other
Assignment Order - (®) Default O Sequential

< Prev Next > Finish | Cancel

Figure 17. Create UUID suffix pool

9. Click Next.

A Create UUID Suffix Pool x

Unified Computing System Manager

sreate UUID Suffix Pool Add UUID Blocks @
1. VDefine Name and
Description & = @ Fiter @>EBpot JPrint o
2. Jadd uUID Blocks Name From To )
No data available

Add 7 Delete

(o<Prev.] [ Next> | |

5

Figure 18. Add UUID block

10. Click Add to add a block of UUIDs.
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11. Select from option as the default setting.

12. Specify a Size for the UUID block.

A Create a Block of UUID Suffixes X
Create a Block of UUID Suffixes ©
From:| |0000-000000000001 | Size :[1 3
< >
[ OK | [ cancel |

Figure 19. Create block of suffixes

13. Click OK.
14. Click Finish.
15. Click OK.

CREATE VLANS

To configure the necessary virtual local area networks (VLANS) for the Cisco UCS
environment, complete the following steps:

—_

In Cisco UCS Manager, click the LAN tab in the navigation pane.
Select LAN > LAN Cloud.

Right-click VLANSs.

Select Create VLANSs.

Enter the Name for VLAN to be used for management traffic.
Click the Common/Global radio button for the scope of the VLAN.
Enter VLAN IDs as the ID of the management VLAN.

W N oo AW

Click the None radio button for Sharing Type.

o PURESTORAGE’ ©2017 Pure Storage, Inc. 18



A Create VLANs X

Create VLANs @

Multicast Policy Name [ <notset- ¥ Create Multicast Policy

(&) Common/Global () Fabric A(D Fabric B Both Fabrics Configured Differently

You are creating global VLANs that map to the same VLAN IDs in all available fabrics.
Enter the range of VLAN IDs (e.g. "2009-2019", "29,35 40-45", "23", "23 34-45")

VLANIDs

Sharing Type : /@ None O Primary O Isolated () Community |

(. Check Overlap | o« [ Cancel |

Figure 20. Create VLAN

9. Click OK, and then click OK again.

CREATE VSANS

To configure the necessary virtual storage area networks (VSANSs) for the Cisco UCS
environment, complete the following steps:

1. In Cisco UCS Manager, click the SAN tab in the navigation pane.
Expand the SAN > SAN Cloud Tree.

Right-click VSANSs.

Select Create VSAN.

Enter the Name for the VSAN for Fabric A.

Click the Disabled radio button for FC Zoning.

Enter VSAN ID.

N o oo s wN
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A Create VSAN X
Create VSAN ©
FC Zoning Settings
FC Zoning : (&) Disabled () Enabled |
Do NOT enable local zoning if fabric is toan FC/FCoE switch.
@® Common/Global O Fabric AQ) Fabric B(O Both Fabrics Configured Differently
You are creating a global VSAN that maps to AVLAN can be used to camy FCoE traffic and can be mapped to this
the same VSAN ID in all available fabrics. VSAN.
Enter the VSAN ID that maps to this VSAN. Enter the VLAN ID that maps to this VSAN.
VSANID : 1 FCOEVLAN @ 1
Cancel

Figure 21. Create VSAN

8. Click OK, and then click OK again to create the VSAN.
9. Right-click VSANSs.

10. Select Create VSAN.

11. Enter the Name for the VSAN for Fabric B.

12. Click the Disabled radio button for FC Zoning.

13. Click the Fabric B radio button.

14. Enter VSAN ID for Fabric B.

CREATE BOOT POLICIES

To create boot policies for the Cisco UCS environment, complete the following steps:

—_

Select Policies > Root.

Right-click Boot Policies.

Select Create Boot Policy.

Enter the Name for the boot policy.

Optional: Enter a Description for the boot policy.

N o oosw N

Uncheck the Reboot on Boot Order Change checkbox.

{® puresTORAGE

In Cisco UCS Manager, in the left navigation pane, click the Servers tab.
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A Create Boot Polcy x
Create Boot Policy ©
vane -
Description
Reboot on Boot Order Change </
Enforce vNICVHBAGSCSI Name ¥
BootMode :|(@ Legacy O Ued
WARNINGS:
The type (primary/secondary) does not indicate a boot order presence.
The eflecive order within the same device class (L s PCle bus scan order.
#Enforce VNICVHBAASC S| Name 5 selacted and the 51 doe: g SITor will ba reporied
Hitis not selected, e VNICSVHBAS are selected if Bey exist othenwise he YNICVHEA with e lowest PCle bus scan order is used.
» Local Devices Boot Order
» VNICS e ifing & Pt @
Name  Order «  WNICV.. | Type WN LUNN.  SiotNu_.  BootNa . BootPath | Descrip
» vHBAS No data available
» ISCSI vNICs
» CIMC Mounted vMedia
a MoveUp ¥ Move Down 7 Delele
Sat Uefi Boot Parameters
oK [ Cancal

Figure 22. Create boot policy.

8. Expand the vHBAs drop-down menu and select Add SAN Boot.

9. Inthe Add SAN Boot dialog box, enter Fabric-A as value for vHBA field.

10. Click the Primary radio button for the Type option.

A Add SAN Boot X

Add SAN Boot @

VHBA  Fabric-A| \

Type :|© Primary ) Secondary |

oK | [ cancel

Figure 23. Add SAN boot on Fabric A

11. Click OK to add the SAN boot initiator.

12. From the vHBA drop-down menu, select Add SAN Boot Target.
13. Enter 1 as the value for Boot Target LUN.
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14. Enter the WWPN for CTO.FCO.
15. Click the Primary radio button for the Type option.

To obtain this information, log in to pure storage, and under the system tab
in the left panel, click the host connection for the target Ports.

16. Click the Primary radio button for the SAN boot target type.

17. Click OK to add the SAN boot target.

18. From the vHBA drop-down menu, select Add SAN Boot Target.
19. Enter 1 as the value for Boot Target LUN.

20.Enter the WWPN for CT1.FCO.

21. Click the Secondary radio button for the Type option.

A Add SAN Boot Target X

Add SAN Boot Target o

Boot Target LUN -/ 1 \

Boot Target WWPN :[ 20:00:00:25:B5:1A:00:00] ]

Type :I@ Primary () Secondary |

ok | [ cancel ||

Figure 24. Add SAN boot target for Fabric A

22.Click OK to add the SAN boot target.
23.From the vHBA drop-down menu, select Add SAN Boot.
24.1n the Add SAN Boot dialog box, enter Fabric-B as the value in the vHBA field.

25.By default, the SAN boot Type will be set to Secondary and the options will
be disabled.
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A Add SAN Boot x

Add SAN Boot e

VHBA : Fabric-B|

Type :| _ Primary (&) Secondary

| [ Cancel |

%

Figure 25. Add SAN boot on Fabric B

26.Click OK to add the SAN boot initiator.

27. From the vHBA drop-down menu, select Add SAN Boot Target.
28.Enter 1 as the value for Boot Target LUN.

29.Enter the WWPN for CTO.FC1.

30.Click the Primary radio button for the SAN boot target type.

31. Click OK to add the SAN boot target.

32.From the VHBA drop-down menu, select Add SAN Boot Target.
33.Enter 1 as the value for Boot Target LUN.

34.Enter the WWPN for CT1.FC1

A Add SAN Boot Target X

Add SAN Boot Target ©

Boot Target LUN : 1

Boot Target WWPN :| 20:00:00:25:B5:1A:00:01

Type :|O Primary (@) Secondary

Lok ] [ cancel ]

Figure 26. Add SAN boot target for Fabric B

35.Click the Secondary radio button for the Type option.
36.Click OK to add the SAN boot target.
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37. Click OK, then click OK again to create the boot policy.

CREATE SERVICE PROFILE

To create service profile, complete the following steps:

In Cisco UCS Manager, in the left navigation pane, click the Servers tab.

—_

Select Service Profile > Root.

Right-click root.

> W N

To open the Create Service Profile Export wizard, select Create Service
Profile Export.

5. lIdentify the Service Profile:
a. Enter the Name for the service profile.
b. Under UUID, select the UUID_Pool.
c. Click Next.
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A Creste Servica Profila (axpen)

Unified Computing System Manager

Create Sexvnxe Protle (gl

1. ¥ Identify Service
Protike

2 Jstorage Provisioning

3 INetworking

4 o Conmectnty

Identify Service Profile ©
You must enter 2 name for the service profile. You can akso specify how 2 UUID will be assigned to this profile and enter a description of the
profile.

Name : SOFS-Serverl

g s name s
Where - org-root
Specity how e UUID wil be assigned 1o the server associated with Sis service profile.
uuo

wuo. [TBL-UUID(170/200) ]
Select (pool defoult used by defaul)
Create UUID Suffix Pool
Hardware Default

20000000000 X0 X00E-X00000OO000

JMere e Sennice Profii2 SNOUS DE USed.

< Prev Net > | Fnsh | | Cancel

Uptonary enter a 025CNERON K e PO €
TBL

default(0/0)

Figure 28. Identify service profile

6. Configure the Networking options:
a. Retain the default setting for Dynamic vNIC Connection Policy.

b. Click the Expert radio button to configure the LAN connectivity.

A Create Service Profiie (expert) x

Unified Computing System Manager

Create Service Prote (expert)

1. ¥ 1dentfy Service Profle
2 VSeeage Provisiening
3 ¥ Networking

4 Jsan Connectwy

& vaiciniea lacement
7. JvMedka pokey

& Jserver Boot Order

9. Jntantenance Poilcy
10, Server Asssgnement

Networking ®
Optisnally specify LAN configuration informatien.

Dynamsic vNIC Connection Pokicy| Select 2 Policy 1o use (no Dynamic vNIC Polcy by detaul) |

Create Dynamic WIC Connection Policy

Mow woukd you e 10 configure LAN connectivy?
© Semple(3) Expert() No¥NICs () Hardware inheriied () Use Connectivty Polcy

Cick Add 10 Spaciy 6 of more VAICS That the server shoukd 656 1 connect 10 e LAN
Name MAC Address Fabac 1D
No cata avadatie

1. Joperational Pebioes

3 Dette K3 AGd '3 Moty

<Pev ] (Met> | (Faueh | [Conce |

Figure 29. Configure networking

c. Click the upper Add button to add a vNIC1.

d. Inthe Create VNIC dialog box, enter the Name for vNIC.
e. Under MAC, Select the Mac_Pool.

f. Inthe Fabric ID, select the Enable Failover.

g. Select the Management Vlan.

h. Under Pin Group, Select the Pin Group.

i. From the Adapter Policy list, select Windows.

{® puresTORAGE

©2017 Pure Storage, Inc. 25



A Creata WIC x

Create VNIC =

Name wlgi
MAC Address
MAC Adtecs Pesgamont gt 11 AT/109) ]

Create MAC Pool

The MAC address wil be automatically assioned from the selected ool

Use vNIC Template :[]
Create WNIC Template

FabiciD : (@ FabdcA (O FabicR Enable Failover

VLAN in LAN cloud wil take the pracedanca over the Appliance Cloud when there is a name clash.
VLAN:

& Fiter wExpot (4 Print Siv
Select Name Native VLAN
= getaun o 2
=iscsivianio o)
=1 pvr-vLAn-101 O
Hvian 172 O
% = vian2001 O v
i - S
[fox ) [Cancel
Figure 30. Creating virtual network interface (vNIC)
j.  Click OK, and then click the upper Add button to add a vNIC2
(@bove Same Steps).
A Creste Service Profile (expert) x
Unified Computing System Manager
(Create Servica Prosie sy Networking )
Optionally specify LAN configuration information.
; :m;’*‘m Dynamic YNIC Conmacticn Polcy | Select a Polcy 10 use (no Dynamic VNIC Pokcy by dataut) ¥ ] n
3 Y Networking
4 s connecey E3 Create Dynamic WIC Connection Policy
[ { Jl-.
§ AR gty 81 ot LN st

) Smple (&) Expert () No vNICs ) Hardware Inberited () Use Connectivity Policy

® I Mantenance Policy Chck Add 10 5pecity 06 of More vNICs Mt ne server should use 1o connect 1o the LAN
Name MAC Address Fabnc 10 Natve VAN
v Bwac wicz Derved BA

M Notwork Vian 2001 ©

© e AB |

3 Octete £ Ada ([ Moasy

<Prev | | Next» | | Fnsh | | Gancdl |

Figure 31. vNIC added

k. Click Next.

7. Configure the Storage options:

a. Retain the default setting for Local Disk Configuration Policy.

b. Click the Expert radio button to configure the SAN connectivity.
From the WWNN Assignment list, select WWNN_Pool.
Click the Add button to add a vHBA.

o o
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e. Inthe Create VHBA dialog box, enter the Name for vHBA!1.

f. Under WWPN, select the WWPN_Pool.
g. Inthe Fabric ID, select the Fabric A.
h. Under VSAN, Select the VSAN for Fabric A.

Under Pin Group, Select the Pin Group.

j.  From the Adapter Policy list, select Windows.

A Croate vHBA x
Create vHBA @
Name : vHBA1 »
World Wide Port Name
WWPN Assignment | TBLWWPN-FI-A(40/100) K

Create WWPN Pool

The WWPN will be assigned from the selected pool
The availableftotal WWPNs are displayed afler the pool name.

Use vHBA Template -]
Create vHBA Template

FabriclD -[@A OB
Select VSAN | VSAN-200 v Create VSAN
PNGIOWD ~ <notsets | 7 v
OK | (-Cancel |

Figure 32. Create virtual host bus adapter (vHBA)

k. Click OK, and then click the upper Add button to add a vHBA2
(follow same steps).

Groste Survice Profie (exgerd) i

Unified Computing System Manager

oste SAN C. tivi .
" Optienally specify disk policies and SAN configuration information.
1. ¥ ety Sevice Profie
2 ¥ Sormge Provisenng Salect WYNN assignment opson ~
s Jmm selacted the wor poot
4. ¥ SAN Connectivity WARNING: The Sa(ectad ponl 6085 not contam any avalabie entmes g
5 zonng R tnat w0k
& Jumicpmea sacnmenr
7. A steda wobcy

Namo WwPN
11, JOperabonel Pokicies w s
8 \HoA I VSAN-300
v =8 Hpa vieAT Dertved
W vHeaA 1 VSAN 200

F Ookote E3AM 5 Modity

Cabrov]) (Kot > ] Chosh) [Gacdl.)

Figure 33. SAN connectivity
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[.  Click Next.
8. Set no Zoning options and click Next.
9. Setthe vNIC/VHBA placement options:

a. Assign the vHBASs/VNICs to the virtual network interfaces policy in the
following order:

- VHBA1
. VvHBA2
« VNIC1
« VNIC2

b. Review the table to verify that all of the vNICs and vHBAs were assigned
to the policy in the appropriate order.

A Crasta Sanicn Profia (sxpert) x

Unified Computing System Manager

Croate Senvice Protie (wmat) ~ VNICIVHBA Placement -
Specify how vNICs and vHRAs are placed om phyvical network adapters
1 ¥ tdenty Senvce rofle 00448 Pracement specfies how YNICs and YHBAS are ol adaptors
2v 13 sorver way A
3V Networkng %
2 V30 Cormecthl SeCt PIacement Lot System Perform Placement v| & Croate Pacement Pelicy
6 ViZenng
6 :Iﬂlclnﬂw ¥ ot vNICS and on PCI order.
i J L Namg Aodress Oroer -
8 server oot Order . pescny .
J [ VHEA YHEAY
':J > A vraaz Derived 2
A vwc wict Deeived 3
11, Joperational Pekses
Bvwc wicz Deewed 4

A Movallp W Move Dosn (j Nelate (% Raceer 13 Maddy

Figure 34. Placement of vNIC and vHBAs

10. Set no vMedia Policy and click Next.
11. Set the Server Boot Order:
a. From the Boot Policy list, select Boot-Policy from SAN.

b. Review the table to verify that all the boot devices were created and identified.
Verify that the boot devices are in the correct boot sequence.
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Unified Computing System Manager

Optionally specify the boot palicy for this senice profile.

STAAINTHCAATI00
SAAGET6AAT:R:10

SOAAQRTHAAAT:Q0:00
S2ANOI RN L

[ <prev | [ MNext> | [ Fnih | [ Coel |

Figure 35. Server boot order view

c. Click Next.
12. Add a Maintenance Policy:
a. Confirm that maintenance policy is set to default.
13. Specify the Server Assignment:
a. Assign later, Click Next.
14. Operational Policies.
a. Default BIOS settings.
15. Click Finish to create the service profile template.

16. Click OK in the confirmation message.

STEP 2 -
CONFIGURE BOOT FROM SAN

The first step prior to installing and configuring the Windows Storage Server 2016 hosts

is to provision the storage required for SAN boot. Before the storage can be provisioned,
you must obtain the connectivity information (Fibre Channel WWNs) for each host so they
can be configured on the FlashArray. The quickest way to do this is to use UCS Manager.
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Cisco Unified Computing System (UCS) Manager

Single pont device management 31(1h)

Launch UCS Manager Launch KVM Manager
1.6 o higher
HTML

Launch UCS Manager Launch KVM Manager

KVM launches require 1.6 o Nigher

o Strow Agani?

ministrative Configur:

Download UCS Contral

alialn srer £ s s a3 A e e oo c g = o
] kg

cisco

Figure 36. Cisco UCS Manager

1. Launch the UCS Manager by navigating to Fully-Qualified Domain Name (FQDN) or IP.

2. After clicking Launch UCS Manager, a download prompt for the Java Network
Launch Protocol file (.jnlp) will appear. Download and run this file — note that Java
Runtime Environment (JRE) 2 must be installed to run the UCS Manager.

It is recommended to use the HTML version of the UCS Manager.

3. Login to the UCS Manager with proper credentials (default user name is “admin”).

o For bestresults use a supported browser v

ucs
‘a’ Unified Computing System Manager

I { S 3.1(1h)

Username

Password

W

S cisco

ver & e
each 3uch Iceme b avallable at. Mg,/ OpeTICUTE O ICen3 e/ g2 0.p0D and hitp /e OpeTITRTCE O Icena e ip
210

Figure 37. UCS Manager login
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4. Inthe Equipment tab, select the Chassis object and then expand one of the server

objects down to the HBA object: Chassis > Servers > Server # > Adapters > HBAs >

HBA #. Select each of the “HBA” objects to record their WWNSs.

Q © oNewr | Zostors |9 O |1 Pending Acvites | 3 Fnd | @ |

) Sustcs.
vropaes
w2
Vendor -Cisco Systema inc
VHBA - epanot/le M2 Barkr 0 fe Bl
PCle Address 08000
WAPN  2000:00:25:85:11:11:3C
Onginal WAPN - 00:00:00:00:00:00:00:00
VNN 20:00:00:25:85:44:00:06
et VVVNN  09.90.:90:09:00:00,00:00
Fabric Port v/ chassis 2/ddot 1/hact/port 9 Puposs :Genaratl

nName vHBAY Type Virtast

Save (hanges Reset Vaots

Fault Summary
s 5 7 2 #h equomen -
€ Equipment Servers LAN D »  Gemecal Fauls Events
e o summary
v~ Chanae i ® V A A
o 1] ot
AP Chassis 2
@l Fans Status.
@ 10 Moules
Ve Operaddity - ¢ Operabie
oo Servers
» o Server 1 o
o Server2 8 Reset Conmectivity
) -
~W Adacsars
+ W Adapter 1 =B osdle
» -4 OCE ntertaces ]
=@ HBAS -
AHeat =
B L ".
AHeas -
E Lot
»-gNCs
* @ SCtvCs
> Ratenc d
» o Seners
» < Servers
[
-
> Chasss 3
*&p Chasss &
*& Chasss 5|
e KaOMOUS
orox
> @ Servers
~H Fabric nlescornects
» I Fabic Intercennect A (primary) -
B Logged i as adming@10.21.88.56

System Tme: 2016.12.23722:00

Figure 38. Server 3 showing HBA adapater information

5. The WWN is listed on the right panel after selecting an HBA under the General tab

in the Properties box. The correct WWN will be listed as the WWPN (worldwide port

name). Gather the WWN of each HBA for each server and note them down.
For example, HBA 2 WWPN shown below.

VHBA

Original WWNN
Fabric Port

Name

:20:00:00:25:B5:11:11:.

FSM Statistics
= Properties
D :2
Vendor :Cisco Systems Inc

: org-root/ls-CH2-Barkz-03/fc-vHBAL

00.0

:20:00:00:25:85:44:00:0E
:00:00:00:00:00:00:00:00
:sys/chassis-2/slot-1/host/port-9

.vHBA1

Purpose :General

Type :Virtual

Figure 39. HBA 2 WWPN

6. Once all the WWNs have been gathered for the respective hosts, login to the
FlashArray GUI via its virtual IP address with a supported internet browser.

{® puresTORAGE

©2017 Pure Storage, Inc. 31




7. Click on the Storage tab in the Pure Storage FlashArray GUI and click the plus sign
+ next to the Hosts panel on the left. Click Create Host Group; a dialog appears.
Provide a name for the host group. For this deployment guide the name
SoFS-HGroup is given.

o PURESTORAGE

F o
+ Hosts

+ Volumes +

Il voumes [ Snapshons [ Stareaspace [ Sysem [ Empty Space

Figure 40. Create Host Group

Create Host Group

Name: | SoFS-HGroup|

Create Multiple.... Cancel ROO

Figure 41. Name new host group

8. Now that the host group is created hosts can be added. This will allow for private
boot volumes to be provisioned to each host. To do so, select the newly created
host group under the Hosts panel on the left. Click on the gear icon or as shown
the ‘hamburger’ menu = in the lower right panel that appears in the Hosts tab.
Select the Add Hosts option.

o Holp | Terms | Log Out
PURESTORAGE Weicome pureuser Soed
=
» Hosts + . E SoFS.HGroup :rc. sioned _rou Reduction
» Volumes + § Uses
| I volumes Snapsnots
| 0 0
I Hosts (0)

I No hasts have heen added I Add Hosts

Figure 42. Create host using Add Hosts menu item

9. Before the hosts can be added to the host group, they need to be created on the
FlashArray. Creation of a host means assigning a friendly name to one or more
initiators (WWNs). In the window that popped up, click the Create New Host button.
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Add Hosts to Host Group = SoFS-HGroup *
e la I = I HI Selected Hosts

DR Vo hosts are available.

Figure 43. Create new host

10. Click the Create Multiple button at the bottom of the dialog. This will allow for quick
creation of all hosts. Enter a name for the hosts followed directly (no space) with a #
sign (and optionally a suffix). The # sign will be replaced with a number incremented
by one for each additional host. Also indicate a starting number, a count (humber of
hosts to create), and how many digits (a value of 1 would make the first number “1”, a
value of 2 would make it “01” etc.).

Create Multiple Hosts

Enter name pattern in the form ‘prefucreutix’.

Name: | SoFs-Nodes|
Start number: 1

Count: 2

Numbes of Dights: | 2

Create Singie... Cancel |

Figure 44. Create multiple hosts

11. Now that all the hosts are added to the host group, the proper WWNs need to be
associated with each host, so that the volumes can be connected. Click Confirm.
The hosts are now populated in the host group’s Hosts panel. Select the first host
by clicking on the name.
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o= SoFS-Node01

o= SofS-Node02

Figure 45. Hosts added to host group
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{5 SoFS-HGroup
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) i\v’o\un‘c: Isnﬂp;hcb
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Lo Y
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o= SoFS-Node01

» Volumes |+ J| | o= SoFS-Node02

Figure 46. Host group and hosts

12. In the new panel that appears, click on the Host Ports tab, then click on the gear
icon on the right-hand side and select Configure Fibre Channel WWNSs.

Help | Tenms | Log Out
Welcome pureuser 1o solutions-lab-bis-405-c03-20

0 PURESTORAGE R

Search Hosts and Volumes Q!

_
Da=@ Reoucton | =

[ SoFS-Node01 rrovisionea 7ol Reoucson
10157 #1001 1 4101

P Hosts |~ P2 Sors oroup
aoFs ———met % Used
Y116

=
| B SoFs-HGroup Vohumes [ Suapshos
1236 o

= SoFS-NodeO1

o= SoFS-Node02 1
[

PORT

Figure 47. Configure Fibre Channel WWNs
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13. In the window that appears, a series of WWNs will appear in the Existing WWNs
table on the left. Refer to the information gathered earlier and click on the proper
WWNs for the selected host to add them. Clicking them will push them from
the Existing WWNSs table on the left to the Selected WWNs table on the right.
Doing so and clicking the Confirm button adds them to the host. Repeat this
process for all the hosts.

Help ' Terms  Log Out
Weicome pureuser t 405 )
(‘ PURESTORAGE
= o
SbFS-NOde(H Provisioned Total Reduction Data Reduction | we
- Hosts ) |~ PR sors Horoup 10157 >100t01 4101 =
SoFS 3 Used
— NRE:TS
S ERHO0w J Vorumes I Snapshots
== SoFS-Node01 . 1236 0

o= SoFS-Node02
= -

PORT

P 2000:00:2585:11:11:3C

P 0000025 8244443C

» Volumes

|+

Figure 48. SoFS-NodeO1 showing two added WWPNs

Once all the hosts have been configured, the boot volumes can be configured. But first, it
is important to verify proper and redundant connectivity from each host to the FlashArray.
The FlashArray GUI has a very simple way to check connectivity — click on the System tab
and then Host Connections. In the right-hand pane, a list of all the hosts will appear with
their WWNSs and indicate whether or not that host has redundant connections (connected
to both controllers). If one or more hosts do not have the green “Redundant Connections”
label, re-check zoning and cabling until they do.

Heip  Terms = Log Out

o PURESTORAGE Welcome pureuser

SYSTEM

System Healtn B Host Connections

HOST PATHS » N " ion

o S0FS-Noded1 K Y 2 3

ome SoFS-Node02 K i 2 0
Host Connections

Target Ports

Pugins.

481 Q0I0RITORY) VNI

Figure 49. Host Connections
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Connection Map for host 'SoFS-Node01'

PATHS
Redundant

0 200000258511:113C

B2 2000:00258544443C

Figure 50. SoFS-Node01 showing CTO and CT1FC ports

If all the hosts are redundantly connected to the FlashArray, it is time to create and
provision boot volumes to each host. All boot volumes can be created at once, in a
similar fashion to how the hosts were created.

1. Click on the Storage tab in the FlashArray GUI and then click the plus + sign
next to the Volumes panel on the left. In the dialog that appears, click the
Create Multiple... button.

Figure 51. Create mutliple volumes

Create Multiple Volumes

ENter name pamarm in me 10 PrefxFsumix .

Name: SoFS-Boot-#
Provisioned Size: 150

Start number: 1

Count: 2

Number of Digits: i 1

Figure 52. Example of creating multiple SoFS-Boot volumes
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2. Enter a name for the volumes, followed directly (no space) with a # sign (and
optionally a suffix). The # sign will be replaced with a number incremented by one
for each additional volume. Also, indicate a size, starting number, a count (number of
volumes to create) and how many digits (a value of 1 would make the first number “17,

a value of 2 would make it “O1” etc.).

Once the volumes have been created, they can be connected to the hosts. Itis
important to remember that these volumes should be connected individually, one
per each host. Boot volumes should not be connected to the host group object
which would effectively share them with every host in the host group. Instead, they
should be accessed exclusively by the booting host.

Now that the host group is created hosts can be added. This will allow for private

boot volumes to be provisioned to each host. To do so, select the newly created host
group under the Hosts panel on the left. Click on the Connected Volumes tab on the

right-hand panel that appears. Then click on the ‘hamburger’ icon

= in the lower

right panel that appears in the Hosts tab. Select the Add Hosts option.

Help ' Terms = Log Out
‘ % Welcome pureuser " b-b15-405-009-20
PURESTORAGE b
=l -
SOFS-Node01 Frovisoned Tom Reducton Dala Reguction | ==

~ Hosts | ¥ PR Sorshroup 300006 >100to1 4111 =

sofs X Used

= D 1226

= sors-.(mup i Volumes Snapshots

w= SOFS-Node01 1226 0

o= SoFS-Node02

~ Volumes +)

Nave PROVISIONED VOLUMES  SNAPSHOTS Re i Connedt Volumes l

Download CSV

Figure 53. Connect volumes

5. Find the proper boot volume for the selected host and click on the volume in the
Existing Volumes table on the left to move it to the Selected Volumes table on

the right. Click the Confirm button to complete the operation and to provision the
volume. Repeat this process for each host, assigning one unique volume directly to

each host. Windows Storage Server 2016 can now be installed.
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Figure 54. SoFS-NodeO1 with connected boot and data volumes

This process can be automated using the Pure Storage PowerShell SDK. The automated
workflow for Steps 1— 5 is as follows:

$FlashArray = New-PfaArray -EndPoint solutions-lab-bfs-405-c09-20.lab.purestorage.
com”

-Credentials (Get-Credential) -lgnoreCertificateError

ForEach ($iin 1..2) {

$bootVol = New-PfaVolume -Array $FlashArray -VolumeName "SoFS-Boot-$i"
-Unit G -Size 150

$dataVol = New-PfaVolume -Array $FlashArray -VolumeName "SoFS-Data-$i"*
-Unit G -Size 150

New-PfaHostVolumeConnection -Array $FlashArray -VolumeName $bootVol.name "
-HostName "SoFS-Node0$i" -LUN 1

New-PfaHostVolumeConnection -Array $FlashArray -VolumeName $dataVol.name*

-HostName "SoFS-Node0$i" -LUN 2

Get-PfaVolumes -Array $FlashArray | ?{ $_.name -like *SoFS-Boot*' }
Get-PfaHostVolumeConnections -Array $FlashArray -Name 'SoFS-Node0O1'
Get-PfaHostVolumeConnections -Array $FlashArray -Name 'SoFS-Node02'
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STEP 3 -
DEPLOY WINDOWS SERVER

After you create Cisco UCS service profiles, you must associate available servers to the
created service profiles.

1. Navigate to the Server tab in UCS Manager.
2. Locate the Service Profile created in Step 1 — UCS Manager Configuration.
3. From the root node, right click the <<service profile name>> (Eg. CH2-Barkz-03) and

click Associate with Server Pool.
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Figure 55. Associate with Server Pool

4. From the Equipment console, right click the required server, and select
KVM Console.
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Figure 56. Access the KVM console

5. Ensure that the SAN boot LUNs are discovered and displayed on the BIOS screen.

- a1 A (Cs - 2 Serve - 1 - KVM Cansaennched By o]
fio Vow Macon Tash Voo Mok by
§ xRt

T

Figure 57. Pure Storage boot LUNs

6. Configure the Virtual Media by Activating Virtual Devices and then map the
Windows Storage Server 2016 ISO image to automatically start installation
after a Reset.

7. After starting the installation, select the Cisco VIC driver pack from the appropriate
ISO image using the Virtual Device as in Step 6. Windows Storage Server 2016 will
continue setup until successful completion.
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See the UCS Driver Installation for Common Operating Systems for VIC Drivers,
http://www.cisco.com/c/en/us/support/docs/servers-unified-computing/ucs-
manager/116349-technote-product-00.html.

A csco-6248up-1-b11-
File View Macroz Teol:

<% Stutadoen i
KM Consale | Froperties

Look in: LICS driver

ucs-booo-diivers.).0.2b
) uies-beos-divers-linue3.1.1
68 uies-bronee drivers-windows,3.1.1

File name: uce-bove-drivers.2.2.3¢.is0

Flles of type: sk ks Fls (%, le0)

Figure 58. UCS Boot Drivers

STEP 4 -

DEPLOYING WINDOWS SERVER

FAILOVER CLUSTER

1. After successful completion of Windows Storage Server 2016 installation and
reboots from the previous section, start Server Manager and select the Local Server
within Server Manager > Add Roles and Features Wizard. From the Features

section, enable Multipath I/0 and Failover Clustering.

 PuRESTORAGE
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Figure 59. Add Roles and Features Wizard

Click Next and complete the installation process. This will not require a reboot.
3. Open a Windows PowerShell console and enter:
New-MSDSMSupportedHW -Vendorld 'PURE' -Productld 'FlashArray'.

4. From Server Manager, click Tools > MPIO. The MPIO Properties screen appears.
From the MPIO Devices tab, ensure that the Pure Storage FlashArray is discovered.

PURE FlashArray Multi-Path Disk Device Properties X

General Polcies Volumes MPIO Driver Details Events

Selectthe MPIO policy: | Least Queue Depth v
Descripti
The least queue depth policy compensates for uneven loads by
distributing ionately more |/0 reqy to lightly loaded
processing paths.
DSM Name: | Microsoft DSM | ] Detais
This device has the following paths:
Path Id Path State TPG... TPG State Wei. A
77020001 Active/Optimi... 0 Active/Optimi...
77040000 Active/Optimi... 0 Active/Optimi... v
< >

To edt the path settings for the MPIO policy, select a
path and ek Ed.

Te the ings and selected MPIO ) ]

o 1 conce

Figure 60. Windows Storage Server 2016 MPIO Properties
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5. Verify multipath is configured correctly by starting an elevated command prompt
and entering the following:

mpclaim —-s -d

The MPIO disk is displayed in the result if the configuration was successful.

B8 Administrator: Command Prompt 9

Figure 61. Checking mulipathing with mpclaim

Figure 60 shows that all MPIO Disks are using the Load Balancing policy of Least
Queue Depth (LQD). This is documented as part of the Pure Storage Windows
Server Best Practices located at https://support.purestorage.com.

6. From Pure Storage FlashArray//M20 Web Management interface, in the Systems tab,
from the Host Connections option, ensure that multipath is configured, as required.

Help  Terms Log Out
. el Nt
Connection Map for host ‘SoFS-Node01' x

Q

Host Port Connectivity
System H

P 20:00.00258544.443C L >3
Connects » - g
Host Co

Target A

Users

Phugins Show Hosts Only Download CSV ﬁ

— crv-aeyi-NG - M 2 n

Purty 401 (010TOATT oS es

Figure 62. FlashArray host redundant connections
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DEPLOYING WINDOWS SERVER FAILOVER CLUSTERS

CREATING FAILOVER CLUSTERING FEATURE

—_

Start Server Manager.
On the Manage menu, click Add Roles and Features.

On the Before you begin page, click Next.

> W N

On the Select installation type page, click Role-based or Feature-based installation,
and then click Next.

5. On the Select destination server page, click the server where you want to install
the feature, and then click Next.

6. On the Select server roles page, click Next.
On the Select features page, select the Failover Clustering check box.

8. To install the failover cluster management tools, click Add Features, and then
click Next.

9. On the Confirm installation selections page, click Install.
10. When the installation is completed, click Close.

11. Repeat this procedure on every server that you want to add as a failover
cluster node.

VALIDATE THE CLUSTER CONFIGURATION

1. Before you create a failover cluster, you must validate the nodes have been
configured as required.

2. To do this on a server, start Server Manager, and then on the Tools menu, click
Failover Cluster Manager > Create Cluster Wizard.

8 Failover Cluster Manager =|a] X
File Action View Help
«=| 2(m B
8 Faiover Cluster Manager Nodes (4) Actions
W 'v:sc-wsw.wmm.. Seorch y o v ]l * L) - -
9 Roles Lot
2 Nodes Hame Status Assgned Vote Cusrert Vote Irfomation P addNode..
a ._"Sl_ouqe View »
H m @ Refresh
B Networks ? Select Servers Help
4] Cluster Events
Before You Begn Saect the servers 10 23310 the cluster B Pouse »
B Reume ,
Vi Waming 51| % Remote Desktop
Corfrmation | | [ Bowse. F= | @ information Detaits.
Configure the Cluster s e [ Show Critical Events
. e 1| B3 More Actions »
Help
< Previous. Cancel
= ,'W_HWI&I“IM

Figure 63. Create Cluster Wizard
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3. Ifthe Select Servers page appears, in the Enter server name textbox, enter the
NetBIOS name or the fully qualified domain name (FQDN) of a server to participate in
the failover cluster, then click Add.

4. From the Validate Warning page, click Run all tests (recommended), and then
click Next.

Do not select the Reboot on Boot Order Change checkbox.

5. On the Access Point for Administering the Cluster page, In the Cluster Name box,
enter a name for the cluster.

6. Click Next and Finish.

Once you've completed creating the clusters, verify that the storage, nodes, disk, and
network are up and running:
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File Acion \View Help
«s|nmEm
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Y, Q;’:'m"‘“’”"‘“"" Search || Guenes | v :
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N
g“"‘“‘;’ 2 sevey ®w 1 1 G Rereh

B Hee

& Pause »
|| B Reume v
|E

@ Infarmation Netaile

o [ Stww Criticel Everts

Uptime raTav] 8. MorsActens X
Memory: 243 GB Avalable. 2% GB Totdl e
Processors. (20) rtekR) Xeon(R) CPU E5-2630 v2 @ 2.80GHz

CPU Usage. "

Operating System: Mcrosoh Windows Storage Server 2016 Standard
Version: 10014333

Service Pack: No Service Pack instaled
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Figure 64. Windows Server Failover Cluster
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STEP 5 -
CONFIGURING CONTINUOUSLY
AVAILABLE FILE SHARES

Before you begin creating Continuously Available File Shares (CAFS), you must ensure
that the following pre-requisites are met:

« Operating System is Windows Storage Server 2016 and at least a two-node
Windows Server Failover Cluster.

- The File and Storage Services and File Server role must be installed on all
cluster nodes.

- SMB client computers must be running Windows 8 or higher and/or Windows Server
2012 or higher to take advantage of the new SMB Transparent Failover capability.

« The clustered file server must be configured with one or more file shares that use
the new continuously available setting.

We recommend that you design your network to contain multiple pathways
between nodes to prevent the network from becoming a single point of failure.
You can also consider using network adapter teaming and multiple switches and/
or redundant routers to add resiliency to your network configuration.

7. From any of the nodes in the cluster, open Failover Cluster Manager, and then
right-click the Roles node in the left navigation pane. This opens the High
Availability Wizard.

& Failover Cluster Manager
File Action View Help
e 2@ HE

Q [ailover Cluster Manager
v Bj) SOFS-WSFClab.purestorag ™~
3 Rolec

5 No  ConfigureRole.. | Rotus Tive Owner Node Prorty
> ji: ::: Virtual Machines... > A (® Running ScaleOut File Server  Server(d Medium
{4 cu Create Empty Role
View >
Refresh
Help

Figure 65. Configure a Role in Windows Server Failover Cluster

8. From the Select Role step, choose File Server. The file server role supports both the
general purpose and scale-out application types of CAFS. Click Next.
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o § CET | I+ >
- Generic Appiication
ﬁorfugureH»gh = Genens Serpt
Summary 5 HyperV Replica Broker
C-iSCS Target Server v
<Previous | Net> | Cancel

Figure 66. High Availability Wizard

9. From the File Server Type page, choose the option File Server for General Use.
This option can be used for both Windows SMB-based file shares and NFS-based
file shares. It also supports data deduplication, DFS replication, and data encryption.

Click Next.

85 High Availability Wizard

@ File Server Type

Betore You Begin Select an opbon for a clustered file server:
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Select Storage
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Availabilty Use this option to provide storage for server applications or vitual machines that leave files open for
extended penods of time. Scale-Out File Server clent connections are distibuted across nodes in the

Summary cluster for better throughput. This option supports the SMB protocal. It does not support the NFS
protocol, DFS Ry ion, o Fle Server R Manager.

More sbout chustered fils secver options

| <Previous [ Net> || Cancel

Figure 67. File Server Type

10. In the Client Access Point page, provide a server name and an IP address. Clients
use the server name when they access the CAFS. This name will be registered in
your DNS, and clients will use it like a server name. In addition, the general purpose

CAFS also needs an IP address. Click Next.
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85 High Availability Wizard
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Figure 68. Client Access Point

11. From the Select Storage page, select the storage that will be available to the
cluster. The selected storage must be listed under the cluster's storage node and

designated as available storage. Click Next.

purpose Continuously Available File Shares.

Preassigned Clustered Shared Volumes (CSV) cannot be used for your general

85 High Availability Wizard

@Seledsmmge
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Figure 69. Select Storage

12. On the Confirmation page, review your settings. Click Next if you do not want to

make further changes.
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Figure 70. Confirmation for HA File Server creation

13. The Configure High Availability dialog box opens and displays the status of the
configuration process. When the process is complete, the Summary screen appears.

Click Finish.

# High Availability Wizard

55—

To view the report created by the wizard, cick View Report.
To close this wizard. chck Finish.
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Figure 71. File Server completed

 PuresTORAGE:

©2017 Pure Storage, Inc. 49



CONCLUSION

Scalability, agility, reliability, performance, and management are just some of the core
bullet points that IT managers and administrators require in the data center. Using the
Scale-Out File Services Design Guide provides a reference for compute, networking, and
storage platform that provides all the core bullet points mentioned, along with the ability
to scale and grow as business demands require.

The Scale-Out File Services Design Guide can be implemented with any networking or
compute hardware to build out a file share environment for small to large user basis, and
also used for other application workloads.
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APPENDIX 1 -
PURE STORAGE COMPONENTS

This section provides a detailed description of each infrastructure component.

FLASHARRAY//M

FlashArray//M20, one of the mid-range models of FlashArray//M, is a solid state storage
disk system that contains multiple flash memory drives instead of spinning hard disk
drives. FlashArray//M can transfer data to and from solid state drives (SSDs) much faster
than electromechanical disk drives.

FlashArray//M is powered by software that is purpose built for flash — delivering industry-
leading 5:1 average data reduction, proven resiliency with non-disruptive operations and
full performance, and disaster recovery & protection built-in. With the Evergreen™ Storage
model, storage grows and evolves per business needs, providing value for a decade or
more. Capacity, performance, and features can be upgraded non-disruptively without
having to migrate anything.

With FlashArray//M, there is no need for any training or tuning — the installation and use
of FlashArray//M is almost immediate. Additionally, the device can be managed from any
iOS or Android device.

FlashArray/

Figure 72. FlashArray//M20
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The following table lists FlashArray//M20 specifications:

FEATURE SPECIFICATION

- 15— 250+ TBs effective capacity
Capacity

- 5-80 TBs raw capacity

- Upto 200,000 32K IOPS @ < 1ms average latency
Performance

. Upto 6 GB/s bandwidth

« 2-port & 4-port 16 Gb/s Fibre Channel (Onboard)
Connectivity « 4 x10 Gb/s Ethernet iSCSI (Configurable)

« 4 x1Gb/s Management and Replication

. 3U

« 600 Watts (nominal draw)
Physical

« 95 Ibs. (47.6 kg)
« 512”7 x18.94” x 29.72” chassis

Table 1. FlashArray//M20 specifications

Check out complete FlashArray//M20 specifications with the following link.

https://www.purestorage.com/products/flash-array-m/hardware-tech-spec-flash-array.
html

PURITY OPERATING ENVIRONMENT

Purity implements advanced data reduction, storage management, and flash
management features. All Purity features are built-in and included in the base cost of
FlashArray//M.

. Storage Software Built for Flash — FlashCare technology virtualizes the entire pool
of flash within the FlashArray, and allows Purity both to extend the life of, and ensure
maximum performance from, consumer- grade MLC flash.

- Granular and Adaptive — Purity Core is based upon a 512-byte variable block
size metadata layer. This fine-grain metadata enables all of Purity’s data and flash
management services to operate at the highest efficiency.

- Best Data Reduction Available — FlashReduce implements five forms of inline
and post-process data reduction to offer the most complete data reduction in the
industry. Data reduction operates at a 512-byte aligned variable block size to enable
effective reduction across a wide range of mixed workloads without tuning.

- Highly Available and Resilient — FlashProtect implements high availability, dual-
parity RAID-3D, non- disruptive upgrades, and encryption, all of which are designed
to deliver full performance to the FlashArray during any failure or maintenance event.
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- Backup and Disaster Recovery Built In — FlashRecover combines space-
saving snapshots, replication, and protection policies into an end-to-end data
protection and recovery solution that protects data against loss locally and globally.
All FlashProtect services are fully-integrated in the FlashArray and leverage the
native data reduction capabilities.

PURE1® - COMPONENT FEATURES

- Pure1 Manage — Combining local web-based management with cloud-based
monitoring, Purel Manage allows you to manage your FlashArray wherever you are —
with just a web browser or a smartphone mobile app.

« Pure1 Connect — A rich set of APIs, plugin-is, application connectors, and
automation toolkits enable you to connect FlashArray//M to all your data center and
cloud monitoring, management, and orchestration tools.

« Pure1 Support — FlashArray//M is constantly cloud-connected, enabling Pure
Storage to deliver the most proactive support experience possible. Highly trained
staff combined with big data analytics help resolve problems before they start.

« Pure1 Collaborate — Extend your development and support experience online,
leveraging the Purel Collaborate community to get peer-based support, and to share
tips, tricks, and scripts.

APPENDIX 2 -
CISCO COMPONENTS

The Cisco Unified Computing System™ (Cisco UCS) is a next-generation computing
solution for small- to medium-sized businesses that unites compute, network, storage
access, and virtualization into an organized structure designed to reduce total cost of
ownership and introduce vastly improved infrastructure deployment mechanisms at
scale. UCS incorporates a unified network fabric with scalable, modular, and powerful
x86-architecture servers. With an innovative and proven design, Cisco UCS delivers an
architecture that increases cost efficiency, agility, and flexibility beyond what traditional
blade and rack-mount servers provide. Cisco makes organizations more effective by
addressing the real problems that IT managers and executives face and solving them on
a systemic level.
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Figure 73. Cisco Unified Computing System

GREATER TIME-ON-TASK EFFICIENCY

Automated configuration can change an IT organization’s approach from reactive to
proactive. The result is more time for innovation, less time spent on maintenance, and
faster response times. These efficiencies allow IT staff more time to address strategic
business initiatives. They also enable better quality of life for IT staff, which means higher
morale and better staff retention — both critical elements for long-term efficiency.

Cisco UCS Manager is an embedded, model-based management system that allows

IT administrators to set a vast range of server configuration policies, from firmware and
BIOS settings to network and storage connectivity. Individual servers can be deployed
in less time and with fewer steps than in traditional environments. Automation frees staff
from tedious, repetitive, time-consuming chores — often the source of errors that cause
downtime — making the entire data center more cost-effective.

EASIER SCALING

Automation means rapid deployment, reduced opportunity cost, and better capital
resource utilization. With Cisco UCS, rack-mount and blade servers can move from the
loading dock and into production in a “plug-and-play” operation. Automatically configure
blade servers using predefined policies simply by inserting the devices into an open
blade chassis slot. Integrate rack-mount servers by connecting them to top-of-rack Cisco
Nexus® fabric extenders. Since policies make configuration automated and repeatable,
configuring 100 new servers is as straightforward as configuring one server, delivering
agile, cost-effective scaling.

VIRTUAL BLADE CHASSIS

With a separate network and separate management for each chassis, traditional

blade systems are functionally an accidental architecture based on an approach that
compresses all the components of a rack into each and every chassis. Such traditional
blade systems are managed with multiple management tools that are combined to give
the illusion of convergence for what is ultimately a more labor-intensive, error-prone,
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and costly delivery methodology. Rack-mount servers are not integrated and must be
managed separately or through additional tool sets, adding complexity, overhead, and
the burden of more time.

CISCO UCS 5108 CHASSIS

The Cisco UCS Mini chassis is a 6RU chassis that can accommodate up to 8 half-width
blades. The chassis is a Cisco UCS 5108 Blade Server chassis that allows the two I/O
bays at the rear of the chassis to accommodate Fabric Extenders such as the UCS
2208XP or UCS 6324 Fabric Interconnect modules. Cisco UCS Mini works on Intel Xeon
processor E5-2600 with up to 36 CPU processors of 1.5 TB memory.

Having a unified fabric reduces the number of network interface cards (NICs), hosted bus
adapters (HBAs), switches, and cables needed. Cisco UCS 5108 also offers support for
one or two Cisco UCS 2100 Series or Cisco UCS 2200 I/O modules.

o

Figure 74. Cisco UCS 5108 Chassis

CISCO UCS FABRIC INTERCONNECT 6248

The Cisco UCS 6248UP 48-Port Fabric Interconnect is a core part of the Cisco Unified
Computing System. Typically deployed in redundant pairs, the Cisco UCS 6248UP Fabric
Interconnects provide uniform access to both networks and storage. It is highly scalable
and flexible infrastructure.
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Figure 75. Cisco UCS Fl 6248

CISCO NEXUS 5000

The Cisco® 5000 series switches are designed to meet the scaling demands of
virtualized and cloud deployments. These switches support up to 2304 ports in a
single management domain with Cisco FEX architecture. They support large buffers
for congestion management, provide a hardware-based VXLAN (Layer 2, Layer 3,
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and gateway), and are capable of network virtualization generic routing encapsulation
(NVGRE). They deliver integrated Layer 3 services with large table sizes and buffers with
1-microsecond latency.

Figure 76. Cisco Nexus 5000 series switch

CISCO UCS B200-M4 SERVERS

Cisco UCS B200 M4 server is a half-width blade server. Up to eight can reside in the
6-rack-unit (6RU) Cisco UCS 5108 Blade Server Chassis, offering one of the highest
densities of servers per rack unit of blade chassis in the industry.

Cisco UCS B200 M4 is a density-optimized, half-width blade server that supports two
CPU sockets for Intel E5-2600 v3 series CPUs and up to 24 DDR4 DIMMs. It supports
one modular LOM (dedicated slot for Cisco's Virtual Interface Card) and one
mezzanine adapter.

Figure 77: Cisco UCS B200 M4 Blade Server

In addition, Cisco UCS has the architectural advantage of not having to power and cool
excess switches, NICs, and HBAs in each blade server chassis. Having a larger power
budget per blade server provides uncompromised expandability and capabilities, as in
the new Cisco UCS B200 M4 server with its leading memory-slot and drive capacity.
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form by any means without prior written authorization from Pure Storage, Inc. and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS,
REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT ARE DISCLAIMED, EXCEPT TO THE
EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. PURE STORAGE SHALL NOT
BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING,
PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS
DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.
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